Exercise 1: Create a Catalog Item

1. Navigate to Service Catalog > Catalog Builder

ale)'," Favorites  History

‘ Y Catalog Build

v Service Catalog

Catalog Builder ~

2. Click Create new catalog item

NOTE: Notice the ability to create a Catalog Item Template. Creating Templates assists with scaling up new
Catalog Items and provide a consistent user experience to end-users.

feie thn cialeg, Create a new catalog item

e Create a catalog item template



3. Review the steps required to create a Catalog Item.

GETTING STARTED
Let's look at what it takes to create an item

We've laid out the steps into a logical flow, but feel free to move through each step in an order that works for you. Remember, you can
save your item as you go but it will only be available once it has been submitted.

We'll start by having you select the catalog item template you would like to use.

@ @ ® @ © ® @ ©
Template Details Location Questions Settings Access Fullfillment Submit
4. Click Continue.

Cancel Continue

5. Select the "Standard items in the Service Catalog Template”

1 bRl e L R T R B TR L TR S

Standard items in Service Catalog For general purpose help items in Service Catalog

6. Click Use this Item template.

Cancel Use this item template

7. Fill out the Basic info and Item details.

Optional: Attach an image



Details

Provide basic information and details about your item

Basic info

[tem name %

Database Access

Short description

Request Access to ABC database

Item details

Image @

& Attach File

Description

B 7 U #% Verdana -~ 1ipt ~ H- A~A~ P 2 M o |E

Ul
Ikl

=~y i=-
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Morbi non ex non ante sollicitudin iaculis. Morbi placerat faucibus

dapibus. Magcenas conyallis nibh nec pjs| rutrum suscipit. In euismod sagittis elit sodales volutpat. Vestibulum venenatis
eros sit amet erat luctus. vitae eleifend liaula sodales. Morbi sed elit in mi consectetur hendrerit dianissim sit amet nisi.

8. Click Location tab on the left menu or click Continue to Location at the bottom of the
form.

9. The "Standard items in the Service Catalog" Template has all baseline Categories
selected by default. A Catalog Item may appear in more than one Service Catalog and
Category.

Optional: Click the Edit link on Categories and deselect some of the default Categories.



Location

Choose a catalog and category where requesters can find your item

Catalogs Categories

Selected catalogs Selected categories #

Service Catalog Can We Help You? i
Desktops o7
Hardware &
Laptops &
Maintenance and Repair
Mobiles 2
Office &z
Peripherals 3
Printers
Services o7
Software &

Tablets 7

10. Click Questions tab on the left menu or click Continue to Questions at the bottom of the
form.

11. By default, this item template includes the Standard Employee Questions Variable set
for Requested for and Due date.

Optional: Add a few variables if desired.

Questions

Define the questions on your item form

Expand all Insert new question ¥

> Standard Employee Questions Single-fow Question Set

Which database do you need access {07 * Choice - Dropdown (fred values)



12. Click Settings tab on the left menu or click Continue to Settings at the bottom of the
form.

13. On the Settings page, set basic configurations for the Catalog Item. Some of these may
be read-only due to the Catalog Item Template configuration.

Optional: Configure additional settings for the Catalog Item.

Settings

Adjust the portal settings and submit button label for your item
| g Y

Portal settings

Submit button label &

Submit
Hide 'Add to cart' button
Hide 'Add to wishlist' button
Hide quantity selector
Hide delivery time
(| Hide attachment button

|| Make attachment mandatory

14. Click Access tab on the left menu or click Continue to Access at the bottom of the form.

15. On the Access tab, define who is allowed (or not allowed) to see this item on the Access
page.
The Catalog and Categories were configured on the Location tab, and may have existing User Criteria security

rules. The Access configurations allow us to further restrict the visibility of this item. By default, this template
doesn’t allow the configuration of Access.



Access

Select which users or groups can access your catalog item
Available for Not available for
User criteria granted access User criteria denied access

16. Click Fulfillment tab on the left menu or click Continue to Fulfillment at the bottom of
the form.

17. On the Fulfillment page, select the process engine that facilitates the fulfillment of the
request. Select “Service Catalog item request”

Our template restricts the selection only to Flow Designer Flows. For now, select “Service Catalog item request” as
a placeholder until the new Flow is created in Exercise 3.

Fulfillment

Select the fulfillment process that you would like to associate with this catalog item

Fulfillment method

Process engine

Flow Designer flow

Selected flow >k

Service Catalog item request




18. Click Review and Submit tab on the left menu or click Continue to Review and Submit at
the bottom of the form.

19. Review the Catalog Item configurations and click Submit when done

20. Check point: Navigate to the Service Catalog and order the newly created Catalog Item

Exercise 2: Create a Data Lookup table

1. Navigate to System Definition > Tables

OW Al Favorites  History

| Y Tables

v Reports

‘ Import Tables A
v System Clone p

v Clone Definition

‘ Exclude Tables Build app

v System Definition

Build low-co«
scale cross-
Tables & Columns All on one pla

Decision Tables

v Remote Tables




2. Click New

Extends table
Application File
(empty)
Application File

Application File

) Actions on selected rows... V'

Extensible
false
false
false

false

3. Label the Table "Flow Router Activity"

Name: (This value is automatically populated)

Updated

2022-02-0201:38:31
2022-02-0201:26:29
2022-02-02 01:40:37
2022-02-02 01:40:37

Atable is a collection of records in the database. Each record corresponds to a row in a table, and each field on a recor

processes. More Info

% Label |Flow Router Activity|

* Name | u_flow

Extends table

4. Select Data Lookup Matcher Rules for the Extends Table field

Atable is a collection of records in the database. Each record corresponds to arow in a table, and each fi

processes. More Info

X Label
>} Name

Extends table

Flow Router Activity

u_flow_router_activity

Data Lookup Matcher Rules

a|le)




5. Click Service Catalog for the Add module to menu field

le, and each field on a record corresponds to a column on that table. Applications use tables and records to manage data and ‘

Application Global

Create module

Create mobile module

Add module to menu | H ) v

Q_ service ca

Service Catalog

New menu name




6. On the Controls tab, replace the new user role with catalog_builder_editor

Columns Controls = Application Access

Extensible | |

Livefeed | |

Use auto-numbering to define a sequential identifying code made up of a

Auto-number | |

Security Rules (ACLs) are required if anyone other than an administrator

Create access controls

> Userrole | catalog_builder_editor




7. Click the Columns tab

‘ Columns \ Controls  Application Access

= Y TableColumns | for text » | Search

Dictionary Entries

Q_ Column label Type
Active True/False
Order Integer
Sys D Sys ID (GUID)

(lace Queteam (Clace Nlamea



8. In the embedded list below add fields to the table.

Dictionary Entries
Q. Column label Type Reference Max length De
Active True/False (empty) 40 tru
Order Integer (empty) 40 10
Sys D Sys ID (GUID) (empty) 32
Class System Class Name (empty) 80 jav
Created by String (empty) 40
Created Date/Time (empty) 40
SysID Sys ID (GUID) {empty) 32
Updates Integer (empty) 40
Display name String {empty) 255
Package Reference Package 32
Protection policy String (empty) 40
Application Reference Application 32 jav
Updated by String (empty) 40
Updated Date/Time (empty) 40
Update name String {empty) 250
Sys 1D Sys 1D (GUID) (empty) 32
Insert a new row...
9. Add fields to the Table
Field name Type Other Attributes

Catalog item Reference = Reference: Catalog ltem [sc_cat_item]

Activity type Choice

Approval group Reference  Reference: Group [sys_user_group]

Task short description String Max length: 160

Task description String Max length: 4000

Task assignment group  Reference = Reference: Group [sys_user_group]



10. Right click the form header and click Save

N\
it

4._.

Track in Update Sets

1 applications, click here.
Configure b

Export

arecord corresponds to a cc . ions use tables and records t¢
Create Favorite

Copy URL

Apsiic] Copy sys._id

Reload form

Create module

Create mobile module

Add module to menu | Service Catalog v

11. Click Approval group

Favorites  History ~ Workspaces Table - Flow Router Activity = O Search *x a2 o @
= Iwknmgr,qﬂm;\. & = - | Update | Debets | Delete All Records |
! A table is a collection of records in the database. Each record correspands to a row in a tabie, and each field on a record toacol hist kable. ications use tables and records to manage data

| and processes. Mare [nfo

# Label | Flow Router Activity = Application Global
* Name  w_flow_router_activity

Extendstable DiataLookup Matcher Rules

Columns ~ Controls  Apgplication Access

= 7 TableColumns | Columnlsbel = | Search @ 1ito20ef22 ¢ W — m
Dictionary Entries
Column lxbel « Reference Max length Default value Display
Artive (empty] 40 true false
Activity type {empty) 40 fabse
Application Apglication 32 javascript:i(typeof parent == ‘abject’)_ false
7 [Bparovalgrour] Group a2 false
Catalog iterm Catalog ftem a2 false
Clas {empty) 80 javascriptcurrent get TableMame(): false
Created {empty) 40 false
Created by String (empty) 40 false
Display name String (empty) 255 false
Order nteger (empty] 40 100 true




12. Set the Reference qual condition to Active is true

Reference Specification ~ Choice List Specification  Default Value

The Reference field specifies what table this field displays values from.

#* Reference Group

Reference qual condition | Add Filtem_ "OR" Clause
Active - (| s v| | true v

13. Click Update

«« | Delete Column | ™ Sl

) enter a column label, which becomes the
reference fields so it appears on records

14. Click Task assignment group

QY5 1L Q¥S IV (\GUIU
Sys ID Sys ID (GUID
X (@ |Task assignment group Reference
X Task description String

15. Set the Reference qual condition to Active is true and Type is empty or Type contains
itil

¥ Reference ‘Group

Reference qual condition { Add Filter Conditlnn} Add "OR" Clause J

All of these conditions must be met

‘. Active b4 ‘ is V_| true V| AND
" Type - ‘ .. is empty v.] [w@ E]
or ‘ Type - ‘ contains VJ itil WE @




16. Click Update

4 =¥ s | Delete Column | ™ ¢

olumn. Also enter a column label, which becomes the
Iy Value for reference fields so it appears on records

17. Click Layout List

[ Update H Delete H Delete AlIR

Related Links

Design Form

Layout-Form
|Layout Listl
Show Form
Show List
Show Schema Map
Add to Service Catalog
Run Point Scan
Explore REST API

18. Edit the list to include the following fields at a minimum:
e Active
e Order
e Activity type
e Catalog item
e Updated

e Updated by



NOTE: It is important that a non-reference field (like Active or Activity type) is the first element in the list, instead
of something like Catalog item, otherwise list navigation is confusing.

Selected

Active

Order

Catalog item

Activity type

Approval group

Task assignment group
Task description

Task short description
Updated —
Updated by

=

) (R

19. Click Save

[ Cancel

Create new field




20. Click Design form

Related Links

Design Form

Layout Form

Layout List

Show Form

Show List

Show Schema Map
Add to Service Catalog
Run Point Scan
Explore REST API

21. Adjust the layout of the form.
Main section, 2 Columns
Column1
e Catalog item
e Activity type
Column 2
e Order
e Active
Section 2, 1 Column
e Approval Group
e Task short description
e Task assignment group

e Task description



-
8 Flow Router Activity [u_flow_router_activity]

I i Catalog item & B i Oder
# Activity type £ B # Acdive
'
i Approval group

¥ Task short description
if Task assignment group

#  Task description

22. Click the gear icon for the Catalog item field

ii Flow Router Activity [u_flow_router_activity]

i Catalog item L8 | i on

i Activity type & B8 i ac

23. Check Mandatory and close the field properties

Cataloaitam Ak
v Properties

Label |Catalog item ’

I Name u_catalog_item
Af

Type Reference

Reference | Catalog Item [sc_cat_item] ‘ W
T4 Default ‘ Q
1 v
Ta Mandatory 3

Read Only [J
RE

Dependent | v




24. Click Save

]

[ o o

25. Click Show List

Related Links

Design Form

Open the default list view for this table

Shetfrrerm

|Show Listl

Show Schema Map
Add to Service Catalog
Run Point Scan
Explore REST API

26. Click New

——
ch New

Updated Updated



27. Right click Activity type and click Configure Choices
* Catalogitem ‘

Ac’::.l.lj.{:l.l_b.mn_L__h.LDM—

Configure Label
Appri  Configure Dictionary
Configure Styles

Task short «
Configure Choices

Task assignn  Show Choice List

Show - 'u_activity_type'

Task @
a3 Watch - 'u_activity_type'




28. Add Approval and Task as options. Click Save

>electea
1 Approval
Task
Add Move up
[ -~
< -
Remove Move down

mk‘l Cancel \

29. Enter the Catalog Item created in Exercise 1

-’z' _  Flow Router Activity &
~  Newrecord

* Catalogitem [DatabaseAccess | Q| |? Order | 100

Activity type | —None- v Active &

i



30. Select Approval from Activity type

% Catalogitem |Database Access ‘ Q ’ ‘ ® \

Activity type | Approval V|

Approval group ‘

sk short description |

31. Right click the form header and click Save

Save

‘ Insert
a|(o]
Insert and Stay
W Show File Properties

Move to Application...

Show Latest Update




32. Right click the form header and click Configure > Ul Policies

Save
Insert

Insert and Stay

Show File Properties

Move to Application...

Order ‘

Active

Show Latest Update
Export >
View >
Create Favorite

Copy URL

Copy sys_id

Show XML

History >
Reload form

Form Design

Form Layout
Related Lists

All
Table

Security Rules

Business Rules
Client Scriots
Data Policies
Ul Actions
Notifications

Dictionary




33. Click New

ted

Order -

34. Set the Short description and Condition

* Short descriptior | show Approval options

When to Apply ~ Seript

Conditions | Add Filter Condition H Add "OR" Clause

Activity type -

Active B

Approval v | AND on| B
. J

| If selected, the Ul Policy applies to all form views; otherwise the Ul Policy is view-specific

35. Right click the form header and click Save

Save

ake fields mr
tions are af

36. Add a Ul Policy Action for Approval Group

Mandatory: true

Visible: true

Configure
Export

v
>

Create Favorite

Apply the Ul policy actions when the form is loaded and when the user changes values on the form

|

rased on these co
llowing condition




Ul Policy Actions {1} Ul Policy Related List Actions

= % | fortext « | Search @ — | Actlonsonselected rows..
Ul policy = show Approval options
| 2 Field name Mandatory Visible Read only
u_approval_group True True Leave alone
1tolofl
37. Navigate back to the list of Ul Policies and click New
ons on selected rows... V‘ m
38. Set the Short description and Condition
e |
Active [
= Short descriptio | show Task options
Vhen to Apply
Conditions Add Filter Condition il Add "OR" Clause i
Activity type b | is VI Task b Elg| |T]

39. Right click the form header and click Save

Configure >

o make fields ir rased on these conditic

y actions are af. Export ?

Create Favorite
Copy URL

- LI |

llowing conditions are



40. Add Ul Policy Actions for the Task fields
Mandatory: true
Visible: true

Ul Policy Actions (3] Ul Policy Related List Actions

= T fortext - | Search & — | Actionsonselected rows.. v m
U1 policy = show Task options
7 < Field name Mandatory Visible Read only
u_task_description True True Leave alone
u_task_assignment_group True True Leave alone
u_task_short_description True True Leave alone
1 to3o0f3

41. Navigate back to the Flow Router Activity table

now Favorites  History = Workspaces

i \ — Ul Policy
Y flow router — show Task options View: Advanced

When to Apply = Script

Flow Router Activities Conditions ‘ Add Filter Condi

| Activity type

‘ If selected, the Ul Policy applies to all form views; oth

Global

‘ Reverse the effects of the Ul policy actions when the |

42. Open the record in the list

All

| Q  Active Order - Catalog item Activity type Approval group

true 100 Database Access Approval (empty)




43. Select a group for Approval

—  Flow Router Activity
100

> Catalogitem | Database Access Q

Activity type | Approval

> Approval group | Database

[ pinte | et |

44. Click Update

¢ 35 - | Update Delete]

100 |
45. Add two additional Flow Router Activities

Activity type: Task

Ensure the order is incremented for each new step.

¢ l = HzaosznuterActmty @& = o | Update || Delete | T &
* Catalogitem IDatabaseAn:cess Q @ Order 200

Activity type | Task v Active B

% Task short description | Configure Access

# Task assignment group | Database

* Task description | Step 1
Step 2
Step 3

Update Delete




46. Check point: There are now three activities in the Flow Router Activity table.

= % E FlowRouter Activities Order - @ | Actions on selected rows.. ~ m

All
<L Active Order - Catalog item Activity type Approval group Task assignment group Task description Task short description Updated Upd:
2022-04-28
true 100 Database Access Approval Database lempty) 18:43:12 admi
Step1
2022-04-28
true 200 Database Access Task {empty} Database Step 2 Configure Access admi
18:43:49
Step 3
Step 1
true 300 Database Access Task {empty) Database San Diego Step 2 Verify Access 204%04-20 admi
Step3 18:44:29

Exercise 3: Create a Dynamic Data-Driven Flow

1. Navigate to Process Automation > Flow Designer

Nnow Al Favorites

‘_ Y  Flow Designer |

v Process Automation

Flow Designer ~

2. Click New > Flow

Flow
Subflow

Action

Updated by



3. Name the Flow. Click Submit.

Suggestion: "Service Catalog Flow Router"

Flow properties

* Flow name Service Catalog Flow Routarl

Description ' Describe your flow

Application

Pratection

Run As

4. Click Add a trigger

TRIGGER

o Add a trigger

ACTIONS




5. Click Service Catalog

o

{ %) Abaort trigger creation
Ny
Trigger Select a Trigger -

. service catalog

APPLICATId Service Catalog

IONS Service Catalog Trigger initiates from a ServiceNow Service Catalog Item Request.

By using the Service Catalog trigger, the flow can be configured on

— a Service Catalog item form and started by a Service Catalog item
(-I—/? Add an Action, Flg reguest,

Mote: Stages are available for all parent Flows, When a Flow is

associated with a Service Catalog Item with the Workflow field,

the flow stages display when the item is requested. Only stages
OR HANDLER from the parent flow display. As the Flow progressas, stages on

paths that the flow did not take are skipped or remaoved from the
error accurs in your flow, € display.

6. Click Done

Delete Cancel

7. Click More Actions menu

Smenu

Test

Data >

b Flow Variables

* Trigger - Service Catalog

> =
4 -Z\ Requested ltem Record _)- Record

( Run Start Time UTC ) Date/Time




8. Click Flow stages

i f”-_-\‘u

Properties

Dat

Executions

b Flow | Flow stages

v Trigge. Manage flow catalog variables

~—— Flow Variables
k| Reg i

9. Click Requested Item and click Add stages.

This action copies the common RITM Flow stages to this Flow.

Flow stages

Requested Item X | Add stages

Mame Value Duration Alw

10. The system displays the Stages to the end user in the order that the records are
displayed on this screen.

This flow uses the Waiting for Approval, Fulfillment, Completed, and Request Cancelled stages. Adjust the
following:

¢ Drag and drop the stage order to be more logical.
e Default the Days value to 0.
e Turn off "Always show" for the Request Cancelled stage.

¢ Delete the Request Approved and Delivery stages.



11. Click Save

Flow stages

i1 Waiting for Approval waiting_for_approval

i+ Fulfillment fulfiliment

;i Completed complete

:: Request Cancelled Request Cancelled

4

12. Click Add action, flow logic, or subflow to end of flow.

@ Service Catalog

ACTIONS

Add action, flov




13. Click Action

TRIGGER

@ Service Catalog

ACTIONS

©)

-4 Flow Logic | - . Subflow

14. Click Look Up Records...

NOTE: There are two Look up Actions, select the plural action that looks up multiple records.
ACTIONS

(;) G Action - & Flow Logic . Subflow

Q, search Actions

error HaN R || 120 7 o

ServiceMow Core
If an error ocd]  ¥¢ Popular
Give User AES Access
INSTALLED SPOKES T Application Intake

@ ServiceNow Core Ask For Approval
ServiceNow Core

@ AES Catalog Builder

@ AES Flow Templates

@ AES Mobile Templates Look Up Records ©
ServiceNow Core :
@ AES Portal Ul Template
Send Notification
@ AES Workspace Ul Templ... ServiceMow Core
@ App Engine Studio Update Record

ServiceMow Core
@ Application Intake

Moot Mhocoedd



15. Click Flow Router Activity as the table

Action Look Up Records -
Table Select a Table - # || B
Conditions | Q. flow m“d
Order by | Flow Router Activity [u_flow router_activity] . o || Ba | atoz
Max Results 1000 | #1 50

16. Add conditions to filter the search to the relevant Flow Router records

17. Set Active is true

Action Look Up Records -

Table Flow Router Activity [u_flow_router_activity] K

&
}’

Conditions Al of these conditions must be met

| - choose field -- v |
@]

Active

Artivita Tuna S -

18. Click AND

= |

vl @ OR AND



19. Click Catalog Item

@ Look Up Flow Router Activity Records @&

Action Look Up Records -

Table Flow Router Activity [u_flow_router_activity]

Conditions  All of these conditions must be mat

Active * is

AND

L -- choose field - -

Q1 catalogitem

Catalog Item )

20. Drag the Trigger - Service Catalog > Requested Item Record > Item from the Data pane

Alternatively, access data pills by clicking on the wand icon to the left of the condition. This displays a filter-like

interface with multiple panes for referential data.

1 Trigger - Service Catalog =Requested ltem Record-~ltem
o Trigger - Service Catalog Requested Item Re...

Up Flow Router Activity Records @ Run Start Time UTC

Table Name
Action Look UP.Records Run Start Date/Time
Table Flow Router Activity [u_flow_router_activity] x

Conditions Al of these conditions must be met

Active o is

Catalog item - Is v ':’_"'-‘gzer-Ser'."r_e [ ><_‘_)

o
21. Click AND
|| mm
vI|&N O OR AND 1

=

record @

ltem

©  OR AND

Configuration item ...

me Configuration item ..

e E
Reference (3}

Reference @ =

Reference (3 th



22. Set Activity Type is Approval
@ Flow % [B

Service Catalog Flow...

=

2 Service Catalog Flow Router i

1 @ Look Up Flow Router Activity Records ®

Action Look Up Records v
Table Flow Router Activity [u_flow_router_activity] Xv |

Conditions  All of these conditions must be met

Active v is
Catalog item v is

Activity type v is

Q|
Active

Order by o Activity type Xv ||
Application ®

Max Results | 1| |1

Approval groups
Catalog item ®

Class

i s =l

23. In the Order field, click Order.

Activity Type b is
Q. order|
Order
Orderby | Selecta fielc v | R au

Max Results 1000 || 25

EEN

AN

atoz



24. Click Done

Delete Cancel

25. Hover just over the Look Up Records Action until an "Add a stage" line appears.

ACTIONS

Q Look Up Flow Router Activity Records where [Active is trua, and Catalog liemis ( Trigger-Serdce €. v ow R |, and Activity Type is Approval)

26. Click Waiting for Approval

Waiting for Approval

Q|

None

Waiting for Approval
Fulfillment

Delivery

<
| |

Completed

b lte.. X ) ' =/ Request Cancelled

/R ©  oRr

5 .

Flow Rout

Count

> Action Sta

HH

w 2 - For Each

> Flow Rout

:

¥ 3 - Ask For A

Approval !

> Action Sta

il

v 4 -LookUpF

1



27. Click Add action, flow logic, or subflow

1 @ Look Up Flow Router Activity Records where [Active is true, an

@ Add action, flow logic, or subflow  (¥lsiile 0

28. Click Flow Logic

ACTIONS

1 @ Look Up Flow Router Activity Records where (Active is true, and Catalog

@ & Action ( =% Flow Logic :) %, Subflow

29. Click For Each
(x) G Action -& Flow Logic %. Subflow
@, search Flow Logics
ERROR HANDLER <
If an error occurs in your flow, the

b

For Each
<+ Do the following until
Do the following in Parallel

Make a decision

AT )

>

Wit fme n rieatiom af ticoo

30. Drag Step 1 > Flow Router Activity Records to the Items.

{-2,) For Each ltem in
emsh,_ 1

Delete

Cancel




31. Click Done

Delete Cancel
¢
b

32. Click Add Action, Flow Logic, or Subflow as a subpath of 2 - For Each

ACTIONS
1 @ Look Up Flow Router Activity Records where (Active is true, and Catalog
'a’-_-"-\ [ -~ e
2 {D,) ForEachltemin ( i-L.. » FlowRouter Activity .. }

=
'{+ } Add an Action, Flow Logic, or Subflow

33. Click Action
ACTIONS

1 @ Look Up Flow Router Activity Records where (s

A (0,) For Each Iltem in '\ 1-L.. * Flow Router Activity

i o

—_—

ArAd an Arrinn Flnw | noic nir S1ifloas



34. Click Ask For Approval

e e ™
P -L_f'_)j"l For Each Item in (\:_- -L.. » Flow Router Activity ... )
(% : G Action ¢, Flow Logic 2. Subflow
B S

1, Search Actions

"\\
\ _
G_J A (©} Most Recent Look Up Record

ServiceNow Care

¥y Popular
ERROR HANDLER INSTALLED SPOKES ~
If an error occurs in | @ ServiceNow Core ‘Ask For Approval o
| BerviceNaw Core: i
@ AES Catalog Builder
Log
e AES Flow Templates ServiceNow Core
Q AES Mobile Templates Look Up Records
- ServiceNow Core

35. Drag the Trigger - Service Catalog > Requested Item Record > Item from the Data pane
into the Record field

 Trigger - Sanice Catalog
NS
Wairing for Approval
@ Livtk LIp Flow Router Activity Records whire (Actve is tue, and Catalog iem is [ Trigger- Sevice©. » . + e, ), &nd AChity Type is Approval) @
(| For Eachivemin { 1-L. * Fiow Router Aciaty . )
@ kv o o —
Actian Ask For Appreval o
¥ Recory [ Trigeer— » Reouested iem x) (o] &
Table Requested ITem [sc_req_mem] i

36. Drag 2 - For Each - Flow Router Activity Record > Approval group into the value for
Anyone approves.

@ Ask For Approval @ h 30
Action | Ask For Approval . 2 - For Each - > Flow Router Activity Record->
- o
% Record | _ Trigger-.. » Requested If Q Trigger - Service Catalag Fliyw Rolitar Activit. focord @

Table | Requested Item [sc_req ° 1 - Look Up Records

- Oy 2-For Each - | : ®
Appraval Field Appraval
Approval group Referance ()
Jjournal Field Approval histary ! i st o)
* Rules EN |
Approve
Anyore approves  w ( 2-ForE.» .» Approvalgro.. X)) NS [ b OR AND @

Miia Nars Nana v walle |



37. Click Done

| ', %

v32

Delete Cancel Done L e
I'.

3

38. Click Add action, flow logic, or subflow

3 @ Ask For Approval @

=

@ Add action, flow logic, or subflow

39. Click Action
. 2 ( ?:;. For Each Item in -:L‘: -L.. » Flow Router Activity ... )
3 @ Ask For Approval @
®
Cj & Action ',3' ~% Flow Logic %, Subflow

40. Click Look Up Records...
®

I,/ﬁ 1 4
\f_() G Action & Flow Logic % Subflow

=

L Search Actions

L Application Intake
RROR HAN (&} Most Recent pplica

Ask For Approval
‘anerror occt  vr Popular

ServiceMow Core

INSTALLED SPOKES A~

@ ServiceMow Core
Look Up Records

@ ~es catalog Builder Sk

@ AES Flow Templates Send Notification

ServiceMow C
@ AES Mobile Templates BEVIEE N, Lale

PR Update Record



41. Click Flow Router Activity as the table

@ Look Up Records @

Action Look Up Records
Table Select a

Conditions | Q. Flow router|

Order by | Flow Router Activity [u_flow_router_activity]

Max Results 1000

42. Set Active is true

@ Look Up Flow Router Activity Records &

Action Look Up Records
Table Fiow Router Activity [u_flow_router_activity]

Conditions  All of these conditions must be met

-- choose field --

s
&}

Active

Order by 5| Activity Type

43. Click AND

&

vl[]| © @ OR

C
Add AND condition C
&

x'

E
=

4
"

& |
}’

atoz



44, Click Catalog Item

ALLon LUUR UP nmeELuius

Table Flow Router Activity [U_flow_router_activity]

Conditions  All of these conditions must be met

| Active
AND

| -- choose field --

Q
Active
order by Activity Type

: Application )]

Max Results 1
| Approval group ®
Catalog Item 63

Class

L |

FEER
| + ) Add an Action, Flow Logic, or Subflow
Nk

-
X || K
- is

b

atoz

E
-

| rue

45. Drag the Trigger - Service Catalog > Requested Item Record > Item from the Data pane

1 Trigger - Service Catalog =Requested ltem Record-~ltem

o Trigger - Service Catalog

Up Flow Router Activity Records @

Requested Item Re...

record @

Run Start Time UTC

Table Name Item
Action Look UP.Records Run Start Date/Time Bateime
Table Flow Router Activity [u_flow_router_activity] x
Conditions Al of these conditions must be met
Active o is _
Catalog item v is “ ':_'ﬂgger-Ser.--r.e Cov ¥ 0 iTE X_) n| B OR AND

46. Click AND

vl[]| © @ OR

Configuration item ...

Configuration item ...

I

Reference (3}

Refel

ference G [
rence (3 th



47. Click Activity Type

Table Flow Router Activity |u_tlow_router_activity] X

All of these conditions must be met

{ Active -

Conditions

AND | catalog Item -
L -- choose field -- -
Active
Order by Activity Type =
1 Application )]
Max Results 1
1 ﬂ.nnrnu:l TFM i f"_\"\
48. Click Task
Action Look Up Records -

"
i

Table Flow Router Activity [u_flow_router_activity] X~ ||

Conditions  All of these conditions must be met

Active - is
AN Catalog lem - is
Artivity Type - is

49. In the Order field, click Order.

Q. order|
| Order
Order by Select 3 field
MMax Results 1000
50. Click Done
»
Delete Cancel

2 || =
is
is
1 || BN '
LRI
~|| true v K& OR
w| [ Trigger:Service Co o0 . » |:c...><__] nl e DR
v | Task v|®| @ ( oOR
- atoz
# || &

AND

AND



51. Click Add a Stage

0 Looh Up Flow Router Activity Records where [Active is true, and Catalop fipm is [ Trigeer - Service €. v v Tte, 1 and Activity Type is Tash
.

52. Click Fulfillment

Fulfillment

(Trigger - Service C... » .. » |te..,>, and Activity type is Task) @ Q

None

Waiting for Approval
Fulfillment

Delivery

Completed

Request Cancelled

53. Click Add action, flow logic, or subflow

4 @ Look Up Flow Router Activity Records where (Act

@ Add action, flow logic, or subflow Iiislile

54. Click Flow Logic

4 @ Look Up Flow Router Activity Records where (Active is true, and Catalog ltem is ':: Tr

- = Flow Logic %, Subflow

(9 & Action

Add a Stage

{ Table Nar
{ Run Start

1-Look Up

Flow Rout

Action 5t

( Flow Rout

b
»
¥ 2 - For Each

» ( Flow Rout

¥ 3-Ask For A



55. Click For Each

4 @ Look Up Flow Router Activity Records where (Active |s true, and Catalog It

(;} G Action -4, Flow Logic . Subflow

M

Q, search Flow Logics

‘RROR HANDLER <

f an error occurs in your flow, the

D, For Each
=7 Do the following until

2 Do the following in Parallel

56. Drag Step 4 > Flow Router Activity Records to the Items.

L0, For Each ltem in

Ralota Cancel m

57. Click Done

Delete Cancel

58. Click Add Action, Flow Logic, or Subflow as a subpath of 5 - For Each

5 |:;£J.;::- For Each Item in (\_4 L.. * Flow Router Activity ... :"J-

()

o

N

Amlod mom A rrimen Fhasae | mmic me Tk flaoo

-3 Ak for dparoial

* 4- Logk Up Recards




59. Click Action

5 -_f')..Ju For Each Item in ( 4-L.. » Flow Router Actiity .. :‘.u

-4 Flow Logic . Subflow

60. Click Create Catalog Task...

Flow Designer provides several actions that can be used to create a Catalog Task, such as Create Record or Create
Task. While these options work to a degree, the Create Catalog Task action is best the tool for the job.

now. | Flow Designer

@ - ;I:::'vc(-l'.-'-lnj: Flow,,
ts  Service Catalog Flow Router i Test acivae (D (-
RGP L0 L IO HALIEY ACIMALY KECOFOS WS [ACTIVE 1 1, AN LASMIG 118 15 || ngase-SeritaL.— v — |, 3N ACEY (e 15 ARSI
- o Data >

o, FarEach itemin { 1- » Fipw Rouler ACtivity

Fultiliment w1 -Look Up Records
) ieseciion b ot G EIRE o —
okl | tatle
n,| FarEach item In { 2-L » Fiow Aoyl Aty
o ) [ Ehwioge ger
* ) C+ Action & Flow Logic % Subfiow b .
-. .: I w1-ForEach
Log = . : .
r Popular - -

ERROR HANDLER | ™NSTALLED SPOKES -
fane GECUrS i vi °5emcehw.lcore

e AES Catalog Butlser

et
@ s Fiow Templates
@ #Es Mabile Templates
Delete Recnrd
@ &5 Foral v Template SerukcaNaw COre
e AES Warkspace LA Templ Tr-ggems... atin
Glana
App Engine Studio .
@ Create Catalog Tash =
@ rpplicanon intzke Seryicehow Lure b
Ll
° viodifies 14

61. Drag the Trigger - Service Catalog > Requested Item Record > Item from the Data pane
into the Requested Item field

Fulfiimant

@ Lank Lip Flaw Rectar ACiuTy Riscards whise (AEUve s true, dnd Cataleg item & { Trgger. Serica £ & . ¢ ta.. ), and Activity Type i Task) @

+5  {o,) ForEachitemin { 4-L_ » Fow Router sty — )

Create Cardlog Task -

Catalog Task [sc_task] -

Trigger - » fléquested em . 3¢ ) | =



62. Drag 5 - For Each - Flow Router Activity Record > Task short description

ttem [Requested  {_ Trigser- . Regquested item . ) R
Iem] RS
Shrt Dascription | 5% . » Taskshom description 3¢ )| 5 E R
Fielis -+ Add field value ; o
Wait | in || R =

Template Catalog siect Template Catalog e
Iterm {Latalog e | 1 B

(Catalog Vanables  Awailable

Select Temp
fialel oy boad

<[]

63. Click Add field value

* Requested

ltem [Requested ( Trigger -.. » Reqguested ltem ...

Item]

Short Description ‘ ( 5-F... » .. » Task short descri...

Fields

wait  |v/|

Template Catalog

Select Template Catalog Item
Item [Catalog Item] EE R

L R B ) Y

Auamilalala

64. Click Assignment group

rrvice Catalog Flow Router inaive

@ Create Catalog Task @

Action | Create Catalog Task

Table Name | Catalog Task [sc_task]

* Requested
[tem [Requested
Item]

( Trigger -... » Reguested ltem ... X)

Short Description ‘ ( 5-F.. ¥ .. » Task short descri... X)

(][

v (“Apprevat graup )
WSS Loty

¥ Package )

i

.
\r‘mfumon policy }

(spsm )

e )

g

b { Tash assignment group )

{{ Task descripnan )
st

(

{ Updace name 1)

Fields Assignment group

X~ | Select Assignment group

|+ Add field value

wait [v]

A

Template Catalog

Select Template Catalog [tem
item [Catalog Item] e v

# |4

Catalog Variables Awvailable

Selected

- o

¥ { Tash short descriptian )

=%



65. Drag 5 - For Each - Flow Router Activity Record > Task assignment group

fikd SN
I 1
K~ |( S5-.. kL P Task assignment ... X)
X | ( 5-For.. * . P Taskdescript.. X)
. ‘O\|
Selected

Create Catalog Itemis) that
point to this flow and the
variables on that itemi(s) will
show here.

> A

66. Click Add field value

IR [ ReEguesied BER

Item]

Short Description

| ( 5-F.. » ... » Task short descri...

an o

= ~][=] ©
[

X) ||E| =

Fields | Assignment group

X | ( 5-.. 'F .. » Task assignment ... X)

Wait  |v |Ei 5_’\_
- - I | i
67. Click Description
termn [REqUESted 'l\_ IMgEer-.. » Kequestea Item ... )"\_/] | ﬂ || E?\ |
ltem] — i
Short Description | 5-F.. » .. » Task short descri... X) H i1 || =

Class

Created [
Created by

Display name

Order

-

-
1
ful
=
o
o
m
Ll
-3
[

Protection policy

Sys 1D

=
o

0 ( Task assignment group

Task description

Task short description

n|®| e

v ‘ ( 5-.. ¥ .. b Taskassignment ... X)

Fields | Assignment group
| Select a field - ‘ ()]
1, descriptio ‘
wait | Description ‘ i1 H =
Template Catalog | Short description
Item [Catalog ltem] —

Catalog Variables Awvailable Selacted

[ e rtaser s I rat s et 1 | [ FEERE SR e IR PLASER 5 I



68. Drag 5 - For Each - Flow Router Activity Record > Task description

oy —
Xw ( 5-.. F .. * Taskassignment ... X} ikd
K~ <_ 5-For.. ¥ .. » Taskdescript. Xj |
1R
>+ Q
Selected
Create Catalog Item(s) that
poin this flow and the
vari 5 on that item(s) wil
69. Click Done
b
-

Delete Cancel

70. Click Add an Action, Flow Logic, or Subflow

G @ Create Catalog Task &

®

:—D Add an Action, Flow Logic, or Subflow

(ONNO}

[ Created hy)
| Display name
I Order_)
L Packagn)
| Protection policy )
| Sys ID_
| Tags
P [ Task assignment group
( Task desulpLiOD
| Task short description )



71. Click Action

@

4 @ Look Up Flow Router Activity Records where (Active is true, and Catalog Iltem is (Trigger -Service Co. b . b ne..._), and Activity Type is Ta:

*'5 {_").,‘- For Each Item in (a -L... P Flow Router Activity ... )
6 @ Create Catalog Task @
@

©

-4, Flow Logic 2. Subflow .

ERROR HANDLER
72. Click Update Record...

6 @ Create Catalog Task @

®

@ G Action - Flow Logic 2, Subflow

Q, Search Actions

OCTVTUETROWY C0TE

(D) Most Recent

ERROR HANI Log
If an error ace] T¢ Popular ServiceMow Core
INSTALLED SPOKES ~ Look Up Records

ServiceNow Core
@ ServiceNow Core

Send Mo Update

e AES Catalog Builder ServiceNg
@ ks Flow Templates Update Record ©
ServiceNow Core {

@ AES Mobile Templates
Delete Record

@ AES Paortal Ul Template ServiceNow Core

@ AES Workspace Ul Templ... Trigger Catalog Item publis...



73. Drag highlighted link

Ip Flow Router Activity Records where (ACTIve IS true, and Cal

ichftemin | 4-L. b Fow Rauser Acow

e Requested Item Record @&

artion | Update Record b
# Record  ( Trmger-— » Reguastad ltem... )
% Table Requested Item [SC_req_item] K-
*+ Fields + Add field value

74. Click Add field value

talog Item 1s { Trigger -Service C bo,w e, )

)

M

7

®

7 @ Update Requested ltem Record &

Action

Update Record

* Record

( Trigger -... » Requested |tem ... X/Z'

* Table

Requested ltemn [sc_req_item]

* Fields

- Add field value |

EE
-
kSN
X |4 R

* Trigger - Sarvce Catalog

75. Add a comment to send to the end user upon completion for the RITM. Use Data Pill
values to make the comment dynamic.

Example comment: Your Item (Data pill: Trigger - Service Catalog > Requested Item Record > Item) was fulfilled.
Please contact the Service Desk for any questions.

Recard -
r-.. b Reguested |tem ... X_I Fikd|
ted Item [sc_req_item] X- | 1
1al comments X~

o

R

Your itern has been fulfilled. Please contact the

L. trigger - Service Catalog>Requested Item Recard-Iterm|

field value

o Trigger - Service Catalog
o 1 - Look Up Records
@}i 2 - For Each -

o 3 - Ask For Approval

o

Run Start Time UTC
Table Name

Run Start Date/Time

Look Up Records

@ 5 - For Each -

r Subflow

@ ©- create Catalog Task

Requested Item Re...

B

Record @ Configuration item ...

Date/Time Configuration item ...
Tahie Mame Iterm
Date/Time

| HIOW HOUTEr ACUVITY 1301

A A
( Count )
o A

3 IK Action Status ;I
* 5- Far Each

bw Router Activity Recc
%

Reference () reate Catalog Task
Reference
@ #talog Task
Reference (&) |
tio

n Status )

pdate Record




76. Click Done

Delete Cancel

77. Click Add an Action, Flow Logic, or Subflow

7 @ Update Reguested Item Record &

@ dd an Action, Flow Logic, or Subflo

78. Click Action

7 @ Update Requested [tem Record &

C;:’ G Action ¢ Flow Logic

%, Subflow



79. Add a Log action for a final "placeholder" to associate with the last Stage.

o

() & Action & Flow Logic
N
Q, search Actions
ERROR HANII (L) Most Recent
If an error occ] 3¢ Popular
INSTALLED SPOKES A

@ ServiceNow Core

e AES Catalog Builder
@ AES Flow Templates
@ AES Mobile Templates
@ AES Portal Ul Template

e AES Workspace Ul Templ...
@ App Engine Studio
@ Application Intake

80. Add a message.

] @ Log @

Action Log
Level Info

Message

81. Click Done

Delete

| Item completed.

¢, Subflow

Look Up Record
ServiceMow Core

Give User AES Access
Application Intake

Ask For Approgie
SarviceNow Co

= B

SeryiceMow Core

Look Up Records
ServiceMow Core

Send Notification
ServiceMow Core

Update Record
ServiceMow Core

L B e

5 |



82. Click Add a Stage above Step 8

Add a stage before Action 8 - Log iny

Add a Stage - £ e
] -\ Cat
==
83. Click Completed
Completed
Q.
None

Waiting for Approval
Fulfillment

Delivery

Completed

Request Cancelled

84. Testing on Catalog Flows can be performed several different ways.

Flow Router Act

Count

P [ Action Status

0l

w 2 - For Each

ﬂ

» ( Flow Router Act

¥ 3 - Ask For Approwv.

!

Approval State

P [ Action Status )

In the following Exercise, it is helpful to have a freshly submitted RITM every time a test is executed. The Flow must

be active to apply when a new Catalog Item is ordered.

The built-in Flow Designer Test functionality is very powerful and records helpful data for troubleshooting. The
system property to enable the logging of runtime data is turned off by default. Check out this ServiceNow Docs

article for more information: Activate flow reporting

Important: To avoid performance issues in a production instance, activate and configure reporting on the non-

production instance that is used for testing.


https://docs.servicenow.com/bundle/sandiego-application-development/page/administer/flow-designer/task/enable-flow-reporting.html

85. Click Activate

Data p

®

Waiting for Approval
w 2 - For Each

4 l':- Flow Router Activity Record -} Record

86. Click Activate

Are you sure you want to
activate the flow?

Your flow will start running when the trigger conditions are met,

Don't show me this again

Cancel Activate




Exercise 4: Test the end-to-end process

1. Navigate to Service Catalog > Catalog Definitions > Maintain Items

g le)","2\| Favorites  History

Y maintain items

v Service Catalog

2. Open the Catalog Item created in Exercise 1.

1l

Y Bl Catalogltems | Updated « | Search

All > Type!=Bundle > Class!=0Order guide > Type !=Package > Class !=Content Item > Published item is empty

| @ Name Short description Active Roles Catalogs Category
Database Request Access to a Service
| i true Can We Help You?
| © Access ABC database Catalog ge e
M\/ Catalog trie Service Can We Heln Yrui?



3. On the Process Engine Tab, change the flow to the new Flow created in Exercise 3.

Item Details | Process Engine | Picture Pricing Portal Settings

Select the appropriate process engine for the catalog Item. Only one engine can be selectec

Flow | Service Catalog Flow Router

Workflow

Execution Plan

4. Right click the form header and click Save

__ Catalogltem
—  Database Access

atalog items are goods or services available to order from the ser
¢ Enter a Name and Short description to display for the item.
« Enter aPrice, approvals, variables, and other information as

Name | Database Access

Catalogs | & \

Service Catalog

Category | Can We Help You?

Save |

Insert
Insert and Stay
Edit in Catalog Builder

Show File Properties
Move to Application...
Show Latest Update

ning from hardwal

Configure
Export

View

Create Favorite
Copy URL

5. Right click the form header and click Configure > Related Lists

Add the related list of Flow Router Activities so that the activities specific to this Catalog Item can be shown in

context.



— Catalog ltem
— Database Access

Save
Insert
-atalog items are goods or services available to order fromthe sery  |nsert and Stay
« Enter a Name and Short description to display for the item. Editin Catalos Biild
» Enter a Price, approvals, variables, and other information as e
Show File Properties
Move to Application...
Name | Database Access Show Latest Update
Catalogs | & Export >
Service Catalog View >
Create Favorite
?
Category | Can We Help You? Copy URL
State Published Copy sys_id
Show XML
Checked out false History S
Reload form
Owner | System Administrator ~TT]

'm Details

Process Engine

Picture  Pricing

Portal Settings

=0
¢ =

hing from hardware, like tablets an

Form Design

Form Lavout

[ RebtedLists
All

Table

Security Rules

Business Rules
Client Scripts
Ul Paolicies
Data Policies
Ul Actions
Notifications

Dictionary

‘.ment autormr

6. Locate the Flow Router Activity List, add it to the top of the Selected lists, and click

Save.

d lists on Catalog Item form

:d Links

Available

Catalog Matcher Variable Definitions->Catalog item
Catalog Setter Variable Definitions->Catalog item
Catalog Template->Catalog item

Catalog Ul Policy Action->Catalog ltem
Composite Record Producer->Published item
Consumable Model->Catalog Item

Content Item->Published item

Contract Model->Catalog Item

Delete Recovery->Initiating metadata

Deleted Application File->Parent

Deleted File Related->Parent

Facility Model->Catalog Item

Flow catalog variable->Catalog item

Flow Router Activity->Catalog item

Hardware Catalog->Published item

Hardware Model->Catalog Item

View name: Default view ~ |

Selected

Variable->Catalog item
Variable Sets

Catalog Ul Policy->Catalog item
Catalog Client Scripts->Catalogitem

Available For

Not Available For
Available at location
Available for company
Available for department
Available for group
Available for user

Not available at Location
Mot available for company
Not available for department
Not available for group
Not available for User

5)
]

Lo 3




7. Check point: Are the Flow Router Activities created in Exercise 2 present in the related
list?

If not, navigate back to the Flow Router Activity table and ensure that the records are associated to the correct
Catalog Item.

Flow Router Activities (3)  Variables (1)  VariableSets{1)  Catalog Ul Policies  Catalog Client Scripts ~ Available For  Not Available For  Categories (1)  Catalogs (1)

Catalog Data Lookup Definitions ~ Related Articles  Related Catalog ltems ~ Assigned Topics

= ¥ | Order - Search @ — | Actionson selected rows... v m
Catalog item = Database Access

Activity type Active Order - Updated Updated by

Approval true 100 2022-04-28 19:54:20 admin

Task true 200 2022-04-28 19:54:20 admin

Task true 300 2022-04-28 19:54:20 admin

8.Click Try It
Y

SE [ Update H Copy “ Try It | Edit in Catalog Builder




9. Fill out the appropriate variables and click Order Now...

& -+ | Q Search catalog v

Order this Iltem

citudin iaculis. Q“a"ﬁt‘/ 1 V‘

In euismod Bellverytime—Sy SBays
leifend ligula
ibh diam, cursus
am et accumsan
‘ Add to Cart |
Shopping Cart

Empty



10. From the Checkout screen, click the Requested Item.

Order Status

Thank you, your request has been submitted

Order Placed: 2022-04-28 19:58:57
Request Number: REQO0010007 <¢

Estimated Delivery Date  2022-04-28
of Complete Order:

Description

I@uest Access to a ABC database|

‘ Back to Catalog ‘ ‘ Continue Shopping

Delivery Date

2022-04-28

11. On the Approvals related list, Approve on behalf of one of the Approvers.

Catalog Tasks  Approvers(3)  Group approvals (1)

= Y |Group ~ | Search

Approval for = RITM0010007

[ ] Q@ state Approver

Requested o
Show Matching

Requested Filter Out

Requested Copy URL to Clipboard
Copy sys_id
Assign Tag >

| Approve |

| Reject ‘

Comments

Stag



12. NOTE: Unlike legacy Workflows, Flows run asynchronously in the background

This means that actions are queued up and processed in the background without making the end-user wait for
completion.

While testing, tasks are commonly completed in rapid succession. This may be a bit cumbersome for us today, this
is almost always faster than in the practice. Processing work asynchronously helps the overall system
performance.

If the tasks are completed faster than the system executes the flow, refresh the RITM to see the next step in the
process.

Beth Anglin's Approval is complete in the example below, but the system has not marked the other Approvals No
Longer Required. Click the breadcrumb to refresh the related list to reveal if the other approvals have been
updated.

= |Gr0up v | Search

Approval for = RITM0010007

] Q  State Approver
Approved Beth Anglin
Requested Fred Luddy

Requested ITIL User



13. Click Catalog Tasks and click the breadcrumb to refresh the list.

T b O % A BB F BELS

Flow Context

Catalog Tasks | Approvers(3)  Group approvals (1)

= Y | Number Search

4

Request item = RITM0010007

Q Number - Assignment group Assigned to

14. Open the task record.

Catalog Tasks (1)  Approvers(3) Group approvals (1)

= Y | Number » | Search

Request item = RITM0010007

| @ Number ~ Assignment group

| @© |SCTASK0010006 Database




15. Assign the task, make a work note and click Close Task
_-—-—-———— =

[-] = CatalogTask . I—] —
|i| =  SCTASKD010006 & + = | Update || Closa Task || Delete
MNumber = SCTASKO010006 Approval | NotYet Requested ~ |
Assignedtey | Freg Lusgy | Q Q| Priority | 4- Low VE

Configuration item | Q State | Open '-'|

Active [ Requestitem | RITMOD10007 | [’,l

Requested for | System Administrator Q | @ |
Short description | Configure Access | [ ¥) || B
SN | S

Description | Step 1
Step 2
Step 3

Work notes | Access configured! ‘

Post |

16. Click the breadcrumb to refresh the Catalog Task list. Open the second task record.

Catalog Tasks (2)  Approvers (3)  Group approvals (1)
= Y ‘ Number v | Search
Request item = RITM0010007
] @ Number ~ Assignment group Assigned to
] © |SCTASK0010007 Database Atlanta (empty)
SCTASK0010006 Database Fred Luddy



17. Assign the task, make a work note and click Close Task

s | = CatalogTask
|| T SCTASK0010007

Assigned to | Bow Ruggeri
Configuration item |

Active B3

@ * = - | update [ CloseTask | Detete 4
MNumber !GCTASKUOlOOD? Approval | Mot Yet Requested W
Q I? Priority | 4-Low o
Q State  Open e
Requestitem | RITM0010007 4, L‘f__\J
Reguested for | System Administrator 3 'TJ
o

| m
Shert description | Verify Access

Description | Step 1
Step 2
Step 3

Work notes | Access verified!

18. Back on the RITM form, right click the form header and click Reload form

©

BOBBE

Save
Add to Visual Task Board
Metries Timaline Opened ‘ 2022-04-28 19:58:57
Configure ? )pened by | System Administrator
Export > .
Gk > Stage Fulfillment
Create Favorite State | Open
Copy URL '
Copy sys_id Quantity
Show XML ) .
— N 1 delivery
kordered I:]

Order Guide ‘




19. Notice the Stage has been set to Completed, the State to Close Conplete.

Reguested Item
RITMO010007

-

Number | RITMOD10007

Item | Database Access

Request | REQO010007

R ted for |$\-'5tern“' inistrator

Due date | 2022-04-28 19:58:56

Configuration item |

‘Watch list I Gl & |

Variables

& * F o | Update
| Opened | 2022-04-28 19:58:57 =

Q m Opened by i System Administrator Q I (O] ‘
o_‘ m Stage Completed
a | |f| State | Closed Complete v
= ! Quantity | 1
Q Estimated delivery | 55

Backordered |

Order Guide | Q|

20. Check point: Does the Comment look like the one in the image?

! Delete .

Where was this comment configured in Exercise 3? What could be wrong? Take a stab at correcting it and order
the Catalog Item again to see if you are correct.

Activities: 3
System

State

System

Field changes » 2022-04-28 20:01:52

Cloged Complete was Opan

Additional comments » 2022-04-28 20:01:52

Your itarn Database Access has bean fulfilled. Please contact the Service Dask for any quastions,

;? System Administrator

Impact
Opaned by
Priarity
Stale  Open

| Update | Delete |
e’ |\ sk

Related Links

21. Congrats! You are done!

Fieldchanges » 2022-04-28 19:58:57

System Administrator

W




